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Overview
This Package contains all the resources needed to recreate the Groove production kit inside
of Cubase 11 Pro, it should also work in Artist but has not been tested.

The intent is to make Song Writing more simple and straightforward. But this kit is highly
complex when compared to the common use of Cubase.

This kit is not intended to be used as a replacement for the Live Session Clip Launching
Groove capabilities of other DAWs. It is not intended to be a Mixing Environment. It is not
intended to be used for Score Composition. It is not intended to be used live, though it
could be used that way, and earlier versions have been. It is highly specialized to a
particular workflow, for Song Writing, Sonic Exploration, and Jamming (by yourself) or with
others.

At first glance Groove reduces a professional DAW to something similar to a 7 track tape
machine while adding needlessly complex routing and naming schemes. But what it
provides is an easy to use, mode-based workflow in which each Channel can be in a
different mode. It is all easily controllable from 1 or 2 Launchpad mini controller pads. Its
creator’s intent was to stay in the groove and not worry about engineering while you are
trying to create music.

The Idea is to abstract the engineering side to a different phase, and since Groove provides
a unified way of accomplishing necessary engineering tasks with the press of a button, one
can focus on making music. That said, it’s very personal, and very unique to its creator. It is
an attempt to make Cubase work the way its crater wishes it worked.

It may not be your thing.



Goals
1. Provide a simple Mode-Based interaction with each Channel independently.

When staying in the groove, you don’t want to stop thinking like a musician
and start thinking like an engineer.

2. Every mode should be able to be activated from every other mode.

3. Provide an Audio only Clip Launching ability similar, though inferior, to what is
used in a live session in most DAWs.

4. Provide a configuration scheme to control the activation of effects on a
channel with a single MIDI toggle while using the least amount of CPU on
smaller, less powerful devices.

5. Provide a way to save instrument kit configurations, with full effects and
routing, and load them independently.

6. Provide a unified recording concept for both MIDI and Audio.

7. Provide a single abstraction for a signal chain or Channel that allows all of
them to be treated the same, thus reducing frustration.

8. Provide an Overdub concept for Audio.

9. Provide a separation between MIDI Control and MIDI Note information so that
each can be fully utilized independently.

10. Provide a Unified Channel Concept in which MIDI, MIDI Control, and Audio are
all valid independent inputs to the Channel.

11. Provide an environment that more closely matched a stage hardware
environment. As musicians we are moving more and more “into the box”,
simplifying the interaction with the DAW to behave more like an
Amp/Pedalboard or Synth/Pedalboard, or Mic/Pedalboard setup just makes
sense.



Components
1. Cubase 11 Pro, Artist should work as well, but has not been tested.
2. Launchpad mini or X. Two (2) pads are better than 1.
3. NI Kontakt, the free version should work but has not been tested.



Environment
The Groove Environment Consists of:

1. 5 Track Regions
2. Arrange Triggering
3. Scripting
4. Launchpad Pages.



5 Track Regions

1. Group Out - Every channel has a group channel as its final routing point.
2. Clips - Every Channel has 8 clips that can be triggered, they are realized with

Sampler tracks.
3. Arranger (Looper) - Clips play through an Arranger, or Looper, these tracks allow for

the triggering and recording and manipulation of the Clips.
4. Deck - The Deck is where audio recording and overdubbing takes place. It is also

where a Kit can be plugged in.
5. Kit - The kit is the construction of an instrument or set of effects. It is the pluggable

part of a Deck

Each “Channel” in Groove consists of many tracks. Each of these tracks contains an
identifier ~1 through ~7. For simplicity when discussing this identifier will be given as ~X,
but understand that there is generally one of each 1-7. Except for Kits, these tracks will be
analogous to the same functional track on a different Channel.

Every bit of text after the “~” is mandatory and can not be changed. However, the text
before the “~” can be anything you want. For instance, if you want to put Drums on Channel
1, and you want to change the name of any Channel 1 track, you could put “Drums” or
“Beats”, or whatever you like before the “~”.

The Positioning of Tracks is likely unorthodox to many, the signal flow in the Project
window tends to go from Bottom to Top, and in the Mixer from Right to Left. This is more
convenient for saving clips, and is more like a Pedalboard or stage positioning. The
exception is the Group Tracks which are on the far right in the mixer and function as a
main mixing board. Any of the sets of tracks can be moved without affecting function.



Channel Colours

Each Channel has a specified colour label. But each Channel is also in order and is
numbered. These colours have no effect on the Scripting and can be changed.

1. Brown - Channel 1
2. Red - Channel 2
3. Orange - Channel 3
4. Yellow - Channel 4
5. Green - Channel 5
6. Blue - Channel 6
7. Violet - Channel 7



Group Out

The endpoint for each channel is a group track identified by ~Xg These serve as a main
mixing board for the groove session.



Clips

The Clips can be found by default in the upper Cubase Track region. This makes them easy
to find, and use when moving a region from the audio track to a Clip.

Each Clip is assigned a separate Trigger Note which is also in the name of the track if you
expand it. Clip Trigger Notes are always on MIDI Channel 14.

Whenever a Channel is put into a Deck Mode the clips for that Channel are arranged in the
upper region so that all of them are accessible. When it is time to add a region to a clip



simply click the Sampler icon (that Black Flag looking thing) on the clip which will open the
sampler edit window below the lower region.

Each clip is named in the following way. Only the text after the “~” is necessary and the rest
can be changed to be more descriptive.

ID: A number between 0 and 7.

Clip ~Xc: indicating that it is a Clip Sampler for the channel

Trigger Note: A Note in a range of the Octave that matches the Channel number.



Arranger or “Looper”

The Arrange or Looper Tracks can be found in the Lower track region in the “Arrange ~ld”
Folder.

The Arrange tracks are stored in a Arrange ~Xld folder.

Trigger Arrange ~Xlm: This track facilitates the triggering of a Channel’s Clips, and records
the MIDI notes which represent a clips performance. This track only accepts MIDI on MIDI
channel 14.

CC Arrange ~Xlc: This track is for MIDI CC (or program change) input to effects placed on
the FX Arrange track.

FX Arrange ~Xlfx: This track serves as the Arrange Bus as well as where any special effects
can be placed.

Tape Arrange (~Xlt): This is the track on which the Audio from a clips performance will be
recorded for the Channel.



Deck

The Deck Tracks can be found in the Lower track region in a separate folder for each
Channel.

The Deck Tracks are stored in a Channel ~Xd folder.

From Top

Bus ~Xb: This is the Bus endpoint for the signal chain from the installed Kit.

Tape ~Xt: This track is where the resulting audio from the Kit is recorded in all but Overdub
mode. The last “Tape” track to have been laid down will always be identified with an “-->”

Overdub Bus ~Xob: This track is a Bus used as the primary output of the deck when not in
Overdub Mode, or the Bus by which audio is routed to the Overdub Tape.

Overdub Tape ~Xot: This track is where Overdub recording takes place. In Overdub Mode
both the Tape and the Kit audio are routed to the Overdub Bus, and recorded on the
Overdub Tape. If an Overdub has occurred, this track will receive the “-->” identifier.

(No attenuation takes place, so this must be used carefully, and may require volume
adjustments)



Kit

Kits are pluggable components to a Deck. There are rules for how to construct a kit, and in
fact, much of a kit could be constructed in such a way that the generic “Input” tracks could
be part of the Deck. However, the restrictions that can cause, and the extra work to
properly rout a Kit are not worth the convenience of having the Input tacks of a Kit be part
of the Deck.

To create a Kit that will automatically plug in to a given Channel, Simply copy an existing Kit,
and modify.

To store a Kit for later select all of its tracks and

File->Export->Selected Tracks

Remember to give it a useful name and the Channel to which it was connected.

The Kit Tracks are stored in a Kit ~Xdk folder. And typically stored at the bottom of the
Deck or Channel Folder.



Performance or “Input” Tracks:

Each Channel is capable of allowing three types of input MIDI, CC and Audio.

MIDI ~Xpm: This is where MIDI Note and related events enter the Channel.

CC ~Xpc: This is where MIDI CC and Program Change events enter the Channel.

Audio ~Xpa: This is where an Audio Signal enters the Channel.

All three types of signal can enter the Channel at the same time. So one can, for example,
record a guitar, while simultaneously playing a virtual guitar on the same Channel.

Note: The CC and MIDI tracks will be muted when recording or monitored. This avoids
playing anything already recorded on the track!

The CC data (recording automation) is part of the performance, but can be easily recorded
separately, copied and pasted, or routed to a different instrument after recording.
Automation and the Read/Write paradigm are intended to serve this purpose, but this
method is easier, and more simple to use, and reuse. While grooving and recording,
Controls remain as MIDI CC data not tied to any particular automation.

This also allows Note and CC information to be routed separately. If you have a plugin that
takes midi note information to alter the Audio, then the note information can be routed
from the MIDI ~XPm track separately from the CC ~Xpc information.

The rest of the Kit is really up to the individual needs of the piece being produced. But
there are some standards which must be followed. And that is the subject of the next topic.



Kit Construction and Naming Scheme

Other than the freedom to change any text before the “~” Kit construction is the only time
the naming scheme becomes a concern. Simply leave everything after the “~” alone, and
never use a “~” in the name of a track, and everything will be fine.

However in Kit construction the Scripting must be told what to do in which mode. A few
options are available.



Instruments

Instruments are signified with the tag “~Xi” at the end of the name of the instrument track.

That tells the Groove scripting that this track is an instrument in Channel X.

It is typical that instruments will need both MIDI and CC MIDI input, and therefore it is
typical to directly route both the MIDI and the CC track to the instrument. It is also helpful
to colour the Instrument track the same colour as the Kit.

Instruments in the Groove model are treated like rack instruments, but with a track to
more easily manage the Instrument. No MIDI data is recorded on the Instrument Track. It
never needs to be monitored. It is simply a reference to the instrument in the rack. This is
the way Cubase used to work, long ago in the golden age.

There are 3 requirements to link up an Instrument.

1. Route the direct out, or a send from the Performance  MIDI track (~Xpm) to the
instrument.

2. Route the direct out, or a send from the Performance  CC track (~Xpc) to the
instrument.

3. Route the Direct Out of the Instrument to either the Deck Bus (~Xb) or an FX track in
the Kit (~Xfx*)



More than One (1) instrument.

In the Groove Environment more than One instrument (or Kit) can be placed in the same
Channel.

To place another Instrument on a Channel, simply create the Instrument track and tag it
with “~Xi” and route the inputs and outputs appropriately.



Instrument Activation (Toggle) Modes

Instruments (and effects) can have different Activation Modes, which depend on the text
after the primary tag. There are Five (5) Toggles for every Channel.

Automatic (No Additional Tag ~Xi)

In Automatic Mode, whenever a Deck Mode is activated the Instrument will be unmuted,
and if its inserts are bypassed that bypass will be deactivated (Inserts On.)

Effects Automatic (~Xi:Y)

In Effects Automatic Mode, like with Automatic Mode whenever a Deck Mode is activated
the Instrument will be unmuted, and if its inserts are bypassed that bypass will be
deactivated (Inserts On.)

However, if Toggle Y for the Channel is pressed, inserts on the instrument will be bypassed
(Inserts Off). The Instrument will NOT be muted.

Assigned Automatic (~Xi:mY)

In Assigned Automatic Mode, like with Automatic Mode whenever a Deck Mode is activated
the Instrument will be unmuted, and if its inserts are bypassed that bypass will be
deactivated (Inserts On.)

However, if Toggle Y for the Channel is pressed, the Instrument will be muted and all
inserts on the instrument will be bypassed (Inserts Off)



Effects Manual (~Xi_Y)

In Effects Manual Mode, whenever a Deck Mode is activated the Instrument will be
unmuted, but its inserts bypass state  will be unchanged. Typically, if the Channel is off, the
inserts will remain bypassed (Inserts Off.)

However, if Toggle Y for the Channel is pressed, the Instrument will be unmuted and
inserts bypass will be deactivated (Inserts On). Note it only toggles this state, so if inserts
were on, it will turn them off.

Assigned Manual (~Xi_mY)

In Assigned Manual Mode, whenever a Deck Mode is activated the Instrument will be
muted, and its inserts will be bypassed (Inserts Off.)

However, if Toggle Y for the Channel is pressed, the Instrument will be unmuted and all
inserts bypass will be deactivated (Inserts On).



Effects [FX]  (virtual pedalboard):

Effects should be created with an FX Track, and are signified with the tag “~Xfx” at the end
of the name of the FX track.

That tells the Groove scripting that this track is an effect in Channel X.

Effects can also affect the signal flow, they can be either Serial or Parallel.



Serial Effect

A Serial Effect receives an Audio signal and provides the resulting Audio Signal to the next
Effect in the chain, or to the Channel Bus (~Xb) if the effect is at the end of the chain. More
than one insert can be placed on the FX Track, but the Activation Mode will affect all of the
inserts on the Track at once.

If an Effect is Serial it will have no “m” (Toggling will not affect its mute state).

With the signal flow going from bottom to top all of the effects represented here are Serial
Effects.



Parallel Effect

A Parallel Effect receives an Audio Signal directly from an Instrument or a Performance
Track, or from a Serial Effect, and provides the resulting Audio Signal to the Channel Bus
(~Xb), or to a Serial Effect.

If an Effect is Parallel it will have an “m” (Toggling will affect its mute state).

In this diagram the signal flows from bottom to top, and both, Effect A and Effect B are
Parallel.



Is a Track Really Parallel or is it Serial
Care must be taken when assigning a mode to an FX Track in a Kit. There should never be a
case where the signal does not flow through to the bus when a Deck Mode is selected.
Consider the diagram below with signal flow going from bottom to top.

Typically when there are more than one entry point to an effects chain, one of them should
be selected as serial, and therefore always pass signal on, the Direct routing of that Track
should also be Serial. In this example, Effects A, B and C are chosen to be Serial.

Effect A is sending it’s signal to Effect B which can be considered Parallel. But Effect E must
be Serial so that the signal can flow on through to the Bus.

Effect F would then be Parallel.

Effects A could also be parallel, but either A or F should be automatic, so that at least one
option will be selected automatically when the Channel is activated.



Effect Activation (Toggle) Modes

Effects can have different Activation Modes, which depend on the text after the primary
tag. There are Five (5) Toggles for every Channel.

If an Effect is Serial it will have no “m” (Toggling will not affect its mute state).

If an Effect is Parallel it will have an “m” (Toggling will affect its mute state).

Automatic (No Additional Tag ~Xfx)

In Automatic Mode, whenever a Deck Mode is activated the FX will be unmuted, and if its
inserts are bypassed that bypass will be deactivated (Inserts On.)

Serial Automatic (~Xfx:Y)

In Serial Automatic Mode, like with Automatic Mode whenever a Deck Mode is activated the
Effect will be unmuted, and if its inserts are bypassed that bypass will be deactivated
(Inserts On.)

However, if Toggle Y for the Channel is pressed, inserts on the Effect will be bypassed
(Inserts Off). The Effect will NOT be muted. The Audio Signal will continue to flow through
this path.

Parallel Automatic (~Xfx:mY)

In Parallel Automatic Mode, like with Automatic Mode whenever a Deck Mode is activated
the Effect will be unmuted, and if its inserts are bypassed that bypass will be deactivated
(Inserts On.)



However, if Toggle Y for the Channel is pressed, the Effect will be muted and all inserts on
the FX Track will be bypassed (Inserts Off). The Audio Signal will no-longer flow through this
path!

Serial Manual (~Xfx_Y)

In Serial Manual Mode, whenever a Deck Mode is activated the Effect will be unmuted, but
its inserts bypass state will be unchanged. Typically, if the Channel is off, the inserts will
remain bypassed (Inserts Off.)

However, if Toggle Y for the Channel is pressed, the Effect will be unmuted and inserts
bypass will be deactivated (Inserts On). Note it only toggles this state, so if inserts were on,
it will turn them off.

Parallel Manual (~Xfx_mY)

In Parallel Manual Mode, whenever a Deck Mode is activated the Effect will be muted, and
its inserts will be bypassed (Inserts Off.)

However, if Toggle Y for the Channel is pressed, the Effect will be unmuted and all inserts
bypass will be deactivated (Inserts On).



Example

This seems terribly complicated at first, but it is effective in most situations. So an example
is useful.

This example is in the Groove Revelation Example Project. It leaves a lot to be desired, but
has been created only to provide a working example of what is possible.

This example will focus on the Guitar Kit configured on Channel 3.

In this example Both the Warm Chorused Strat, and the Audio Guitar input have been
routed in Parallel to 3 different Amp Simulators, and is shown here in Deck On mode.



● Golden Radar is in Automatic Mode ~3fx
● EMYM is in Parallel Automatic Mode and assigned to Toggle 1 for Channel 3 ~3fx:m1
● Flying V is in Parallel Automatic Mode and assigned to Toggle 2 for Channel 3

~3fx:m2

All 3 Amp Sims provide their direct output to a Vintage Compressor in Serial Mode.

● Vintage Comp is in Serial Automatic Mode and assigned to Toggle 3 for Channel 3
~3fx:3

The Vintage Comp routes it’s output to Tone Booster which is in Serial Manual Mode.

● Tone Booster is in Serial Manual Mode and assigned to Toggle 4 for Channel 3
~3fx_4





Once a Deck 3 Mode is activated, both the Guitar Input and the Halion Instrument will play
through all 3 Amp Sims, which in turn will be routed through the compressor.

If Toggle 1 is pressed, the EMYM Amp Sim will be turned off, and audio  signal will not flow
through it.

If Toggle 2 is pressed, the Flying V Amp Sim will be turned off, and audio signal will not flow
through it.

If Toggle 3 is pressed, the Vintage Comp will be bypassed, but the Audio Signal will still flow
through the FX track.

If Toggle 4 is NOT pressed, the Audio Signal will still flow through the FX track. But if it is
pressed the Tone Booster will be activated.



Deck Modes

There are 10 Deck Modes activated from the Launchpad. 8 Modes are activated from the
Deck page, and 2 Off modes from the Arrange or Looper page.

Deck Launchpad Page

Below is a diagram of the Deck Modes Page on the Launchpad. The Transport Lane is self
explanatory, and can be found on most pages.

The Modes are on the rows with the column representing the Channels in order.

Note: Selected Pads are OFF. The Launchpad and Cubase do not communicate well enough
to have the lights respond to the changing modes, so as modes are selected the previously
selected mode pads will remain off. One must then press twice to reselect a previously



selected mode. But since modes are normally selected from top to bottom, it is nice to
have a visual trail of what has been done on a channel.

Note: It is best to use a Launchpad mini or to turn velocity off on a Launchpad X.
Launchpad Pro features are not necessary for this environment.

In all Deck Modes the corresponding Clip Tracks for the Channel will be arranged in the
Upper Tracks region.



On

In this Mode you can perform and play, but no recording takes place.

In On Mode:

● All Performance Tracks that are present are active. [ ~Xpa, ~XpC, ~Xpm]
● None of the tracks are armed to record.
● Any Automatic Instruments or Effects are activated.  [~Xi, ~Xfx]
● Audio is routed around the Tape to the Overdub Bus. [~Xob]
● The Overdub Bus is routed to the Group. [~Xg]

Record

In this mode the Performance Tracks and the primary Tape Track are recorded.

In Record Mode

● All Performance Tracks that are present are armed to record. [ ~Xpa, ~XpC, ~Xpm]
● The Tape Track is armed for record. [~Xt]
● Any Automatic Instruments or FX are activated. [~Xi, ~Xfx]
● Audio is routed to from the Tape to the Overdub bus. [~Xob]
● The Overdub Bus is routed to the Group. [~Xg]

Play Perform

In this mode what has been recorded on Performance Tracks is played, but the Tape is
muted. This mode can be used to make manual edits to the Performance Tracks, and then
listen to the edits.

In Play Perform Mode

● All Performance Tracks that are present are monitored. [ ~Xpa, ~XpC, ~Xpm]
● The Tape Track is deactivated. [~Xt]
● Any Automatic Instruments or Effects are activated. [~Xi, ~Xfx]



Dub

In this mode what has been recorded on Performance Tracks is played, and recorded to
the Tape. This mode allows edits done to Performance Tracks to be recorded onto the tape.

In Dub Mode

● All Performance Tracks that are present are not monitored and routed to the Bus. [
~Xpa, ~XpC, ~Xpm]

● The Tape Track is set to record, and an arrow is place in the name of the track [~Xt,
→]

● Any Automatic Instruments or Effects are activated. [~Xi, ~Xfx]

Overdub CC

In this mode the controllers can be recorded, while the other Performance Tracks play. The
result is recorded to the Tape.

In Overdub CC Mode

● The MIDI and Audio Performance Tracks that are present are not monitored and
routed to the Bus. [ ~Xpa, ~Xpm]

● The CC track is set to record.[~XpC]
● The Tape Track is set to record, and an arrow is place in the name of the track [~Xt,
→]

● Any Automatic Instruments or Effects are activated. [~Xi, ~Xfx]



Overdub MIDI

In this mode the MIDI Notes can be recorded, while the other Performance Tracks play. The
result is recorded to the Tape. This is very useful when the MIDI notes have some bearing
on the results of an Effect, for an Audio Performance. The MIDI notes can be recorded
separately keeping the original Audio Performance. This can also be done through editing,
but the name of the Template is Groove, and that means feeling it in real time.

In Overdub MIDI Mode

● The CC and Audio Performance Tracks that are present are not monitored and
routed to the Bus. [ ~Xpa, ~XpC,]

● The MIDI track is set to record.[~Xpm]
● The Tape Track is set to record, and an arrow is place in the name of the track [~Xt,
→]

● Any Automatic Instruments or Effects are activated. [~Xi, ~Xfx]

Overdub

In this mode what is already recorded on a Tape Track is routed to the Overdub Tape along
with a Performance. The Performance, and the Overdub Tape are recorded.

In Overdub Mode

● All Performance Tracks that are present are monitored, set to record and routed to
the Bus. [ ~Xpa, ~XpC, ~Xpm]

● The Tape Track is not monitored and routed to the Overdub bus. [~Xt]
● The Overdub Tape Track is set to record. And an arrow is place in the name of the

track [~Xot, →]
● Any Automatic Instruments or Effects are activated. [~Xi, ~Xfx]



Play Tape

In this mode what is already recorded on a Tape Track or on the Overdub Tape track is
played while the rest of the Deck is deactivated. If the last recording mode was to the
Tape, then the Tape track is played. If the last recording mode was to the Overdub Tape,
then the Overdub Tape is played.

This can be tricky because if, for instance, the Overdub Mode was selected, but the Tape
that is desired to play is the primary Tape, then the Overdub Tape will still play. To switch it
back to the Primary Tape, simply select any of the Record Modes other than Overdub, and
then Play Tape (without putting Cubase into Record mode).

Likewise, to play the Overdub Tape after a Primary Tape record mode has been selected,
simply select Overdub (without putting Cubase into Record mode), and then select Play
Tape.

In Play Tape Mode

● All Performance Tracks are muted and deactivated. [ ~Xpa, ~XpC, ~Xpm]
● Any Instruments or Effects are deactivated and  muted. [~Xi, ~Xfx]
● Either the Overdub Tape Track, or the Tape Track is not monitored and routed to

the Group. [~Xt] or [~Xot]. Whichever has the arrow [→]



Saving and Playing a Clip

Once the audio has been recorded to a Tape Track any region can be saved to a clip.

In Cycle mode this can mean that editing and gluing, cutting, or comping is required.

In all Deck Modes the corresponding Clip Tracks for the Channel will be arranged in the
Upper Tracks region. So if you have done other things since recording, simply put that
Channel in On Mode to align it’s Clip Tracks.

Creating a Triggerable Clip

Select the Sampler Icon on the Clip Track You wish to place an Audio Loop into.



The  Sampler Editor will open below the Lower Tracks Region.

Drag the Audio Clip to the Sampler as it suggests.

Do not worry about the triggering note. That has been taken care of in the environment.

Any previous settings from a previous Clip which resided in the same position can be saved
by selecting the lock icon.

You can also mess with the Clip and do all of the things one can do with a Sample.



You will however need to do a couple of more things. Two selections must be made within
the sampler, and an optional 3ed selection may be necessary. You may also want to
rename the Sampler Track (Remember, only Before the “~”)

● Select Zero Crossing to avoid pops.

● Select Continuous from the Loop Mode.

● If you so choose, select the Audio Warp, Music, and SYNC Tempo.



Triggering A Clip and the Trigger Launchpad page

Where you place a clip will determine which pad on the Launchpad Trigger page will play
the Clip.

Below is a diagram of the Deck Modes Page on the Launchpad. The Transport Lane is self
explanatory, and can be found on most pages. The differing shades are intended to aid in
selecting the correct pad.

The light on the pad will go OFF when the associated note is playing on MIDI Channel 14.

Click the Clip Trigger pad associated with the Clip you wish to Trigger, and it will Trigger at
the begging of the next measure.



Note: There is no feedback to the Launchpad when the Note goes to off from within
Cubase.

The Lane Trigger can be used to trigger all of the Clips on the associated row. The lane pad
will go off, but the individual trigger pads will not.

Unlike with most Clip Launching DAWs there is nothing stopping two clips on a Channel
from being triggered simultaneously! So triggering a lane will not turn off any other clips
which are playing.

This is somewhat unfortunate, but in practice it isn’t much of a burden. One has a whole
measure to turn off the undesired Clips, and trigger the desired lane because the OFF is
quantized to a measure as well as the ON.



Arrange “Looper” Modes

The Arrange or Looper allows you to record the trigger events in real time, to apply effects,
on the FX Arrange Track, and to record the resulting Audio to the Tape Arrange Track.

Arrange Launchpad Page

Below is a diagram of the Arrange Modes Page on the Launchpad. The Transport Lane is
self explanatory, and can be found on most pages.

The Modes are on the rows with the column representing the Channels in order.



Mute

This is not a mode, but simply a toggle to but and unmute the Channel’s Group Track  [~Xg]

Version

Trigger will version the recordable Tracks on the Channel's Deck and set the Deck into Off
mode. [ ~Xpa, ~XpC, ~Xpm, ~Xt, ~Xot]

Loop On

This mode will activate the Channels Looper allowing for Clips to be triggered, But nothing
will be recorded.

Record

This mode will activate the Channels CC and Trigger Arrange Tracks for recording.

When Cubase is in record mode, the notes that are triggered will be recorded.

Play Triggers

This mode Triggering Clips from the Launchpad will be dissabled, and the Looper will play
whatever triggers have been recorded.

Overdub CC

Effects that are placed on the FX Arrange Track can modify the Audio signal. The CC track
allows those effects to be controlled in real time. In Overdub CC mode, the the CCs can be
recorded without affecting previously recorded triggers.



Dub

In this mode the recorded Triggers and Controls will play, and be recorded to the Looper’s
Tape. No further changes or Overdubbing will take place.

Play Tape

In this mode whatever has been recorded to the Tape Arrange [~Xlt] track will play, all
other Arrange tracks will be disabled.

Interaction between the Arrange Looper and the Deck

A note on the interaction of the Arrange Looper Modes and the Deck Modes.

Once the Loop On or Version has been pressed, the Deck will be in Off Mode. However,
the Deck can then be placed in any other mode at the same time.

The Template and Example Project should start with all Channel Decks in Off Mode, and all
Arrange Loopers in On Mode.

Activating a Deck Mode will not Deactivate the selected Loop Mode!

However it may be convenient to start a session by placing every Channel in this mode by
selecting the entire row of Loop On pads.

If Groove Agent is to be used, it can be placed in Play Mode on the Deck page. Then each
Channel (Or set of Channels) can then be activated to the appropriate mode as needed.



Effects and the Cubase Arranger Launchpad Page

Below is a diagram of the Arranger Track and Effects or Instrument Toggle buttons

Launchpad page.

The Transport Lande and Arranger Track Controls are self explanatory. The Arrange
Triggers are only coloured differently to aid in finding the desired trigger.

The Toggle buttons are arranged with the Channel in columns and the Toggle buttons from
bottom to top mimicking the signal chain flow in a Deck. The slightly different shades of
colour are only to try and easily spot where which row is which.

As with much of the Launchpad Cubase integration the triggers are off when selected, and
on when not selected.



Unfortunately since there is no usable communication from Cubase to the launchpad,
Once a Toggle has been pressed, it must be re-pressed to Toggle the other direction. The
Launchpad and Cubase do not appear to agree on the Note Off format.

These Toggles can be placed in a foot controller, Or Changed to CC triggers as desired.

It is often more convenient to have foot controllers focussed on the learned MIDI inside of
an Amp Simulator or Plugin, rather than having it controlled by the FX track.

But having different Amp Sims in the same Album focused template, and mapped so that
which are selected  by his page is quite convenient.



Additional Launchpad Pages

Group Faders



VST Quick Controls



Groove Agent

The Upper Drum pad is mapped to MIDI 10 to control the Instrument Pads

The Lower Fancy Drum pad is mapped to MIDI 11 to control the Performance Pads

The Faders are CCs 83, 84, 85, and 86 on MIDI Channel 1



Expressions

A useful page when on the go with the lower octaves for Articulation mapping, a
modulation “fader”, and common and useful On/Off CC mappings.

CC120 ALLSOUNDSOFF

CC 64 SUSTAIN

CC 65 PORTA

CC 66 SOSTENUTO

CC 67 SOFT PEDAL

CC 68 LEGATO

CC 69 HOLD 2

The Notes run in rows from left to right, and bottom to top.



Arrange Loop Triggering MIDI maintenance

The Triggers are accomplished by using MIDI Logical Editors in Transformers, and by
Keeping all of a particular family of operations on different midi Channels.

All of the Transport and Mode Control pads are set to notes on MIDI Channel 15 and 16.

MIDI Channel 14 is dedicated to Clip Triggering.



Triggers per Channel
Each Trigger Arrange Track isolates it’s input to the appropriate Octave and MIDI Channel.

Here is the transformer that is on Trigger Arrange ~6lm.



Clips

Each Clip has 3 Transformers.

Here are the Transformers in order from 0  Clip ~6c G6

This one filters for a single Note on Channel 14



This one ensures that the Sampler Default Trigger Note does not have to change. It
converts the trigger into C3 which is always the Sampler default note.

This last one is to resolve an issue with the Kontakt script that converts Note events with a
value of 1 to also be 0. Since these are all propper toggles that is quite acceptable.



Triggering a Lane

To Trigger Lanes there is a special Track Trigger Arrange Lane

It has a transformers and a Chorder

This one isolates the Notes to Octave 0 on Channel 14.

This Chorder inserts all of the triggers for every octave of a note that comes in.



Quantizing to Bar

All of the trigger Tracks send their MIDI events to a Kontakt instance Arrange Trigger
Kontakt. This is only there to run a simple Kontakt script which quantizes all notes to a
Mesure.

All of the Clip Tracks receive their Notes from the Arrange Trigger Kontakt Track.

The Kontact script is included, and is a modified version of a script that comes with Kontakt.



Scripting

All of the scripting for Groove is accomplished through the use of the tags in Track Names.

There are an abundance of Project Logical Editors (PLE), duplicated for each Channel.

In turn those PLEs are called from a set of key command Macros, again duplicated for each
Channel.

The Macros are then called by a Generic Remote configuration which matches the
assignment in the Launchpad Syx files.

The names of the PLEs were made to mimic what is happening in the PLE itself. However,
mistakes were made, names were changed, and sometimes they just don’t quite match up
exactly.

Some Macros, call other Macros, but all Macros call only other Macros or Macros that call
only PLEs.

Macros that are only called by other Macros begin with and underscore “_”.

Here is an example:

The naming of the PLEs is



● First by Channel,
● then the Macro it is intended to be used in, (though a few were reused in other

Macros),
● Then the original intended order in which the PLE would be placed into the Macro
● A List of the Tracks that are selected
● The changes to the state of those tracks.

So in the above example:

5 _open 0 d open

Channel 5, Macro _open, PLE 0, for tracks with the subtag “d” set their folder state to open.

(This opens the Channel’s folders if they are closed)

5 _open 1 c Dsharp select

Channel 5. Macro _open, PLE 1, for tracks with the subtag “c  D#”, select that track.

(This aligns the clip in the upper region.)

5 _open 2 g monD mutD recD wrtD

Channel 5, Macro _open, PLE 2, for tracks with the subtag “g”, Set:

Monitor Disabled

Mute Disabled

Record Disabled

Write Disabled

Many of the PLEs include these 4 track states, though not all of them were necessary in this
case.

All of the Macros are in the key commands, and all of the PLE files are included.



Installation

To install the environment

Key Commands and Macros

Copy the key commands from :

“Oqion Groove Template\Presets\KeyCommandsGroove Key Commands.xml”

To :

“C:\Users\<me>\AppData\Roaming\Steinberg\Cubase 11_64\Presets\KeyCommands”

Or wherever your Cubase Presets are stored.

Project Logical Editors

Copy the Entire Groove directory (including the directory) from:

“Oqion Groove Template\Presets\Project Logical Editor\Groove”

To:

“C:\Users\<me>\AppData\Roaming\Steinberg\Cubase 11_64\Presets\Project Logical
Editor”

Or wherever your Cubase Presets are stored.



After launching Cubase

Launch Cubase an

Open the Key Commands “Edit -> Key Commands”

Select the Groove Key Commands from the Presets dropdown.

Open Studio setup: Studio -> Studio Setup

Select Add Device, Generic Remote

Then import the Groove Remote file from.

“Oqion Groove Template\Groove Remote.xml”



Select the Launchpad , you will configure in the next section.

If you want you can import the Profile Manager

By selecting Edit -> Profile Manager

The Profile is stored in:

“Oqion Groove Template\Groove.srf”



Configuring a Launchpad

Open Launch Control and select your Launchpad type:

Then select Upload Custom Mode

Browse to where you have saved the Directory

“Oqion Groove Template\Launchpad Syx”

On A Launchpad Mini it is convenient to have at least Groove Deck.syx, and Groove
Arrange.syx

If there is only one Launchpad, and it is a mini then the 3ed custom slot will have to be
Groove Trigger.syx.

In this case it is okay to also have the launchpad also in All Midi because the channels are
different, but you will have to make sure to filter each MIDItrack for the appropriate
Channels. The example Kits have this done already.



The FX Toggle page is called: Groove FX Arange.syx

In this example of a Midi setup, The Launchpad with the controls is called Groove Control.


